The information contained in this document is subject to change without notice and should not be construed as a commitment by Scantron Corporation, which assumes no responsibility for any errors or omissions. Scantron Corporation reserves the right to revise this document and to make changes to the products described herein for the purpose of product improvement at any time, without obligation by Scantron Corporation to notify any person of such revisions or changes.

**Software Version**

This document supports ParTest 7.

**Trademarks**

SCANMARK, ParTest, Scantron and the logo are registered trademarks of Scantron Corporation. All other product names and services referenced in this manual are trademarks or registered trademarks of their respective companies.

Copyright © Scantron Corporation, 2001-2012. All rights reserved. Printed in the United States of America.
# Table of Contents

Module 1: Introduction........................................................................................................................................................................1  
  Managing ParTest.........................................................................................................................................................................................................................................2  
Module 1: Setting Up ParTest Keyword Labels and Lists................................................................................................................................5  
  Setting Difficulty and Discrimination Levels.........................................................................................................................................................................................9  
Module 2: Starting ParTest......................................................................................................................................................................11  
  Instructions, Item Banks, and Objectives..............................................................................................................................................................................................18  
Module 3: Creating Questions.................................................................................................................................................................23  
  Formatting Questions for Import...........................................................................................................................................................................................................35  
Module 4: Creating and Generating a Test...........................................................................................................................................45  
Module 5: Printing Tests & Reports....................................................................................................................................................51  
Module 6: Managing: Instructions, Item Banks, and Tests.....................................................................................................................57  
Module 7: Appendices.......................................................................................................................................................................61  
Module 8: Quick Start Guide.................................................................................................................................................................................69
Module 1: Introduction

What is ParTest? ParTest is a versatile software application that allows you to create instructions, item banks, objectives, questions, tests, and generate reports.

You can import a ParTest Key into ParScore for scoring. After you have completed scoring student forms, item analysis data generated during the scoring process can be posted back to ParTest for evaluating the performance of each question and generating reports.

Available separately, ParTest Online enables a test developed in ParTest to be taken by student via computer rather than paper. Student responses are then scored by ParScore as if they were being read from a scanner. Item analysis data generated during the scoring process can then be posted back to ParTest for evaluating the performance of each question and generating reports.

Contacting Scantron

Our Technical Support Department can be reached at (800) 445-3141 or by Fax at (714) 437-4210 or by E-mail: Support@Scantron.com

We are open Monday through Friday – 5:30 a.m. to 4:30 p.m. (Pacific Time Zone). Closed Weekends and Holidays.

On the Web: http://www.scantron.com click Support

Telephone: (800) 722-6876
Managing ParTest

The “Whole Picture”

1. Administration
2. Creating Item Banks, Objectives & Questions
3. Create & Review the Test
4. Generate the Test
5. Print the Test
6. Export the Key for Scoring
7. Review the Item Analysis from ParScore Postback

ParTest
- Instructions
- Item Banks
- Tests

ParScore
- Roster
- Grading Criteria
- Reports

PTOL
- LAN or Web
- Test Sessions
- Reports

Copyright ©2012 Scantron Corporation
Scantron ParTest Training Workbook
Administrative tasks include: creating and managing user accounts; establishing default values for attribute labels, keyword labels and keyword lists; setting the decision points for the assignment of difficulty and discrimination labels; choosing default fonts and setting the multimedia path for content to be used in ParTest OnLine.

**Note:** When objects are created in ParTest, security features enabled are designed to control access and preserve data integrity. The account an object was created within, is called the Primary User. Objects created by the Primary User can be assigned two different access rights. The Primary User can grant Secondary User privileges to as many as five accounts. Secondary Users have some limited editing privileges on those objects. The Primary User can also grant Public Read Access to objects, which makes those objects available to all accounts, but in a read-only mode with no editing privileges.

### Administrator Login

1. Select Start, Programs
2. ParTest
3. ParTest
4. The default Administrator Login Name and Password are:
   - a. Login Name: administrator
   - b. Password: partest

<table>
<thead>
<tr>
<th>ParTEST Login</th>
</tr>
</thead>
<tbody>
<tr>
<td>User:</td>
</tr>
<tr>
<td>Password:</td>
</tr>
<tr>
<td>OK</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
</tbody>
</table>

### Creating User Accounts

1. Select the “**Tools**” pull-down menu
2. Select “**Administration**”
3. Select “**Add**”
4. Enter the User Name and Password desired
5. From the User List you can Add, Edit, and Delete user accounts. You can edit a user if they forget their password.

![User List Table]

When a new user is added to the user list a new folder is created (E.g.:U1222323) under the Program Data/Scantron/ParTest directory (this is a hidden directory at the Root of the drive). Item Banks and Test files are stored within the user folder.

**Secondary and Public Access Rights:**

The Primary user can assign two types of access rights: Secondary and Public. The Primary user can assign Secondary User privileges. The Secondary User privileges can be granted up to five accounts for each Item Bank and/or Test. Public Read Access cannot be assigned to a Test.

When you designate an Instruction or an Item Bank as public access, the content is available in read-only form to all accounts for use on tests.

**User Rights:**

A Secondary user can edit other test questions while the primary use is accessing another question within the same item bank.

![Assigning User Security Access Table]

**Caution:** We recommend that the Primary user use caution when deleting Instructions, Item Banks, Objectives, and Questions. If you delete these items, the questions and instructions are invalid, and the tests of the secondary and public users can no longer be used.
Setting up ParTest Keyword Labels and Lists

The accepted method for translating course objectives or an outline into test items is the test blueprint. The test blueprint is a two-way grid specifying:

- The course content or objectives.
- The thinking skills an instructor wishes to develop in students (i.e. knowledge of facts, comprehension, application, etc.)

The course content is defined by the course outline. What will be covered in the course and what objectives will be covered in the duration of the course.

The thinking skills the instructor wishes the students to develop during the course is the next dimension of planning. For example, does the instructor want the students to memorize facts, or to analyze, apply, or evaluate knowledge? The students’ ability to memorize, analyze, apply, or evaluate are all thinking skills and will be reflected in the type of test the instructor gives. One example of thinking skills are the Bloom's Taxonomy of Educational Objectives. Bloom’s separates these thinking skills into six areas:

1. Knowledge
2. Comprehension
3. Application
4. Analysis
5. Synthesis
6. Evaluation

Each skill is considered under each succeeding skill. For example, knowledge must be mastered before comprehension can be shown; and comprehension must be mastered before application can be demonstrated.

With the above in mind, the following are suggested plans for schools. The examples are tailored specifically for Nursing or Medical related programs.

Let's start with Keyword Labels and Lists. Key word Labels are useful in helping define questions in respect to the skill levels or ability to sort. Often, the need to know where questions came from (source) is
important. When developing a test, reviewing the objectives or an outline of the course unit is usually done at the beginning. This helps in making sure the test represents the material to be covered.

The Keyword Labels provide a generic terminology for where we want to plan our skill levels first. Source is used for the source of the question information (lecture, textbook, clinic, etc.). Since there could be more than one textbook used in a course, the ability to choose the textbook may be important for evaluation of which textbooks are best in course planning. Identifying which chapters the questions come from help clarify what information the students did or did not comprehend. Bloom’s Taxonomy was explained above. NCLEX allows for the identification of levels within Nursing Programs.

The Keyword List is a finer detailed description of each of the labels, as you see in the examples below.
By setting up the Keyword Labels and Lists in the administrative section, everyone logging in to ParTest will have the advantage of not having to create their own Labels and Lists unless they desired.

The following images show how the Labels and Lists are used in the question properties. Two different examples are shown since there are many applications for the Keyword Labels and Lists.

Next, the image below shows how the Keywords labels and Keyword lists will help in the test configuration, and later, the Test Blueprint.
The last piece, mentioned at the beginning of this document was the objectives. Objectives can be set up as the units within a course, the learning objectives desired for students to accomplish, structure within a textbook, etc. Below are two examples of how objectives could be set up.

When planning Item Banks, Objectives, Tests and Keywords, the most important part of planning is communication between instructors.
Setting Difficulty and Discrimination Levels

Difficulty and discrimination are calculated by ParTest for each question based on item analysis received from ParScore. These values cannot be assigned by a user. The decision points at which specific difficulty and discrimination values are assigned can be set with default values by the Administrator, or can be adjusted individually by a Primary User.

What is the Difficulty Level?

Question difficulty is the percentage of the total group of students who answered the question correctly. Difficulty levels help you determine if the question is Easy, Medium or Difficult based on the item analysis posted from ParScore.

1. Select the “Options” pull-down menu
2. Select Default Levels of Difficulty Setting
3. Change the Minimum and Maximum values if desired
4. Change the Default Labels if desired
Module 1: Introduction
Setting Difficulty and Discrimination Levels

What is the Discrimination Level?

Discrimination is the single best measure of the effectiveness of a question. It measures how well a question discriminates between those who have mastered the materials and those who have not.

Discrimination threshold levels help you determine if the question is Low, Medium, or High based on the student tests scores posted from ParScore version 3.0 or higher.

1. Select the “Options” pull-down menu
2. Default Levels of Discrimination Setting
3. Change the Minimum and Maximum values if desired
4. Change the Default Labels if desired

How does ParScore determine the Discrimination (PBCC)?

The point biserial correlation coefficient (PBCC) measures the correlation between the correct answer on an item and the total test score of a student. The PBCC identifies items that correctly discriminate between high and low groups, as defined by the test as a whole. ParScore reports the point biserial for each item.

Generally, the higher the PBCC the better the item discrimination and the better the item. The following criteria is used to evaluate:

<table>
<thead>
<tr>
<th>PBCC</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>.30 and above</td>
<td>Very good item</td>
</tr>
<tr>
<td>.29 to .20</td>
<td>Reasonably good item</td>
</tr>
<tr>
<td>.19 to .09</td>
<td>Marginal item; needs improvement</td>
</tr>
<tr>
<td>below .09</td>
<td>Poor item; reject or improve</td>
</tr>
</tbody>
</table>
Module 2: Starting ParTest

**User Login**  
If you’re logged into ParTest as the Administrator – Select File, Logout. Enter your User name and password in the ParTest Login screen appears.

1. Select Start, Programs
2. ParTest
3. ParTest
4. Enter your User Name and password

![ParTest Login](image)

**Note:** Each user can change their password under the Tools menu. Passwords must be at least two characters, are not case sensitive and can contain spaces.
Module 2: Starting ParTest

ParTest Work Space

Status bar
Located at the bottom of the screen - the Status bar will indicate the currently selected item and the total number of test questions in the current test.
The Selection window displays the three major branches of information:

- Instructions
- Item Banks/Objectives
- Questions

Selection Window
The Selection Window displays the three major branches of information:

- Instructions
- Item Banks/Objectives
- Questions

To display Instructions, Item Banks, Instructions, and Tests; select the plus (+) sign next to the item to open the contents.

Test Window
The Test Window displays the list of questions assembled in a test file.

<table>
<thead>
<tr>
<th>Exam 1: Test Contents</th>
<th>Item Bank</th>
<th>Objective</th>
<th>Type</th>
<th>Nursing Process</th>
<th>Client Needs</th>
<th>NCL...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Braden 0001</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
<td>MC</td>
<td>A. Assessment</td>
<td>E. Basic Care/Comm...</td>
<td></td>
</tr>
<tr>
<td>2. Nutrition 0001</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>3. Nutrition site 0002</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>4. Culture 0004</td>
<td>Gerontology</td>
<td>Culture</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>5. Culture 2</td>
<td>Gerontology</td>
<td>Culture</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>6. Health Disparities</td>
<td>Gerontology</td>
<td>End of life</td>
<td>MC</td>
<td>D. Implementation</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>7. Palliative care</td>
<td>Gerontology</td>
<td>Elder mistreatment</td>
<td>MC</td>
<td>A. Assessment</td>
<td>B. Safety and Infect...</td>
<td></td>
</tr>
<tr>
<td>8. Caregiver Stress</td>
<td>Gerontology</td>
<td>Elder mistreatment</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>9. Cigarette Burns</td>
<td>Gerontology</td>
<td>Elder mistreatment</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>10. ED Presentation 0001</td>
<td>Gerontology</td>
<td>Elder mistreatment</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>11. Elder abuse cases</td>
<td>Gerontology</td>
<td>Elder mistreatment</td>
<td>MC</td>
<td>A. Assessment</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>12. Palliative care 0001</td>
<td>Gerontology</td>
<td>Entitlements</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>13. Medicare 0001</td>
<td>Gerontology</td>
<td>Entitlements</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>14. Social Security 0001</td>
<td>Gerontology</td>
<td>Entitlements</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>15. Social Security 0002</td>
<td>Gerontology</td>
<td>Entitlements</td>
<td>MC</td>
<td>C. Planning</td>
<td>A. Management of...</td>
<td></td>
</tr>
<tr>
<td>16. LTCI 0001</td>
<td>Gerontology</td>
<td>Finances</td>
<td>MC</td>
<td>B. Analysis</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>17. Medicare 0001</td>
<td>Gerontology</td>
<td>Finances</td>
<td>MC</td>
<td>B. Analysis</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>18. Nursing Home 0001</td>
<td>Gerontology</td>
<td>Finances</td>
<td>MC</td>
<td>C. Planning</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>19. Retirement 0001</td>
<td>Gerontology</td>
<td>Finances</td>
<td>MC</td>
<td>A. Assessment</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>20. Clinical Drugs 0004</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>A. Assessment</td>
<td>F. Pharmacology a...</td>
<td></td>
</tr>
<tr>
<td>21. Compliania 0001</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>A. Assessment</td>
<td>F. Pharmacology a...</td>
<td></td>
</tr>
<tr>
<td>22. Digisolv 0001</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>A. Assessment</td>
<td>F. Pharmacology a...</td>
<td></td>
</tr>
<tr>
<td>23. Education 0001</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>B. Implementation</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>24. Education 0002</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>C. Planning</td>
<td>C. Health Promoti...</td>
<td></td>
</tr>
<tr>
<td>25. Herbal 0001</td>
<td>Gerontology</td>
<td>Gero Pharm &amp; Her...</td>
<td>MC</td>
<td>A. Assessment</td>
<td>F. Pharmacology a...</td>
<td></td>
</tr>
</tbody>
</table>
Add Multiple Secondary Users

Granting Secondary User Privileges

This feature allows for the Primary User to grant up to five accounts Secondary User privileges for Instructions, Item Banks and Tests.

To add a secondary user to a set of instructions, right click on the Instructions and select Properties. Select the secondary user(s) to add in the dropdown menus of the Instruction Properties dialog box. Click OK.

Secondary users can view and edit the Instructions. Please note that secondary users cannot edit instructions after they have been used in a test.
Preferences
1. Select the “Options” pull-down menu
2. Select Preferences

General:
1. Auto prompt to select the Question Type
2. Auto load the last test
3. Show User Access Rights on Instruction, Item Bank and Test

Quick Preview:
1. Select the desired options for the Quick Preview window.
Module 2: Starting ParTest

Test Window: 1. Select the two desired Keywords to be displayed in the Test window.

The purpose of the pull down menus are so you can view your tests based on the two most important keyword labels.

Font Options: 1. Select the desired fonts options for the Default Font for New Questions and Importing a Text File, Header and Footer for Item Bank Details, Test, and Test Details, Number and Answer Labels for Test Only.
Granting Secondary User Privileges to an Item Bank

To grant secondary user privileges to an item bank, right click on the Item Bank and select Properties. Select the accounts to add in the dropdown menus of the Item Bank Information dialog box. Click OK.

Secondary users can view the item bank, and they can add, edit, view and delete questions in the item bank. However, after a question in the item bank has been added to a test, the assignment of secondary users should not be changed as this will cause any tests using those questions to become invalid.
Instructions, Item Banks, and Objectives

Instructions, Item Banks, and Objectives are elements used when you create tests. Before you can create a test, you need to create an Item Bank and an objective to store and retrieve the test questions.

Each Item Bank stores questions of a similar subject. Within each Item Bank, each objective reflects or indicates the course unit that is the focus of the questions. At least one objective must be created to store the questions. You may create as many objectives as necessary.

Creating Instructions

1. Select File, New, Instructions or the “Create New Instruction” icon on the toolbar

The Edit Instruction dialog displays:

2. Enter a Name for the Instruction

3. Enter the Text of the Instruction

4. Select, if desired, Public Read Access

5. Select, if desired, Begin on New Page

   a. You can create and edit instructions for students taking the test.
      - Spelling errors
      - Adding Subscript or Superscript
      - Adding special characters
   b. You can create general instructions that apply to the overall test and/or specific instructions that apply to sections of the test.
   c. You can create as many as you wish
   d. You do not have to create an Instruction if you don’t need it.

![Edit Instruction screenshot]
ParTest allows the creation of multiple versions of an exam. A specific "version" of an exam has the same content as all other versions, but the order and sequence of the questions and answers can be scrambled.

If you need to prevent a group of questions from scrambling - you need to surround the group with instructions. Scrambling of questions will not occur past an instruction.

Sample Instructions:

<table>
<thead>
<tr>
<th>Section</th>
<th>Test Questions</th>
<th>Scrambling Details</th>
</tr>
</thead>
</table>
| Section 1 - Abuse| 6              | Instructions for Section 1
|                  | 1. Abuse 0001  | Six Test Questions
|                  | 2. Abuse 0002  | Only questions in Section 1 will be scrambled within their group       |
|                  | 3. Abuse 0003  |                                                         |
|                  | 4. Abuse 0004  |                                                         |
|                  | 5. Abuse 0005  |                                                         |
|                  | 6. Needs 0001  |                                                         |
| Section 2 - Aging| 3              | Instructions for Section 2
|                  | 7. ADL 0001    | Three Test Questions
|                  | 8. Ageism 0001 | Only questions in Section 2 will be scrambled                         |
|                  | 9. Aging 0001  |                                                         |
| Section 3 - CP   | 2              | Instructions for Section 3
|                  | 10. Braden 0001| Three Test Questions
|                  |                | Only questions in Section 3 will be scrambled                         |
Using an Instruction and “Keep Question Order”

You can also use an Instruction along with a group of questions and the “Keep Question Order” selection. E.g.: If you have a group of questions that relate back to a main paragraph - you would enter the paragraph in an Instruction. You would use the “Keep Question Order” for group of relating Questions.

- The “Instruction” followed by questions that contain the “Keep Answer Order” or “Keep Question Order”
- Those Questions will always remain below the “Instruction” and will not scramble.

<table>
<thead>
<tr>
<th>Exam 1: Test Contents</th>
<th>Item Bank</th>
<th>Objective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instruction for Stat</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section 1 - Abuse</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>1. Abuse 0001</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>2. Abuse 0002</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>3. Abuse 0003</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>4. Abuse 0004</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>5. Abuse 0005</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>6. Neglect 0001</td>
<td>Gerontology</td>
<td>Abuse</td>
</tr>
<tr>
<td>Section 2 - Aging</td>
<td>Gerontology</td>
<td>Aging</td>
</tr>
<tr>
<td>7. ADL 0001</td>
<td>Gerontology</td>
<td>Aging</td>
</tr>
<tr>
<td>8. Agesm 0001</td>
<td>Gerontology</td>
<td>Aging</td>
</tr>
<tr>
<td>9. Aging 0001</td>
<td>Gerontology</td>
<td>Aging</td>
</tr>
<tr>
<td>Section 3 - CP</td>
<td></td>
<td>Clinical Practice</td>
</tr>
<tr>
<td>10. Braden 0001</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
</tr>
</tbody>
</table>
Creating an Item Bank

Item Banks store questions of a similar subject, which are used more than once to create tests. You can create an unlimited number of item banks, and a single item bank can contain up to 5,000 questions. Access to an Item Bank is also user-defined. You can designate an Item Bank for public read access and/or secondary user access.

1. Select the “Create New Item Bank” icon on the Toolbar or Select New Item Bank from the File pull-down menu
2. Enter a name for the Item Bank
3. Enter a description for the Item Bank (optional)
4. Grant Secondary User and/or Public Read Access if desired
5. The “Path” displayed will be your “user” directory. Everything you create in ParTest will be saved to this folder.
Creating Objectives

Objectives are created within an Item Bank to provide more specific focus for a group of closely related test questions. Examples of Objectives for the Item Bank shown below are “Creating Questions”.

**Note:** In Item Bank can contain up to 200 Objectives. (5,000 questions in an Item Bank can be allocated across one objective or several objectives.)

1. Select the Item Bank
2. Select File, New, Objective or the New Objective icon on the Tool bar
3. Enter the Name and Description.
4. Select OK

After you create Objectives, you are ready to create questions.
Module 3: Creating Questions

Question Types
The "unit of measure" in ParTest is the test question. As faculty you are used to thinking in terms of exams. Exams are a set of test questions. Everything in ParTest drills down to the question. The Questions types are:

1. True/False (TF)
2. Multiple Choice (MC)
3. Matching (MT)
4. Fill-in (FI)

Note: Because Fill-in & Essay-problem are subjective questions, they are not supported in ParTest On-line.
Module 3: Creating Questions

**Multiple-Choice:**
1. Enter a Name for the Question
2. Enter the Question Text
3. Enter the available answers and select the correct answer

**True/False:**
1. Enter a Name for the Question
2. Enter the Question Text
3. Select True or False for the correct answer
4. You can change the True/False text if desired
Matching Questions

A matching question is comprised of two parts, the question (or stimulus) and the answer choice (or response). When you create a question, you create the question and the correct answer choice as a pair.

- Matching Questions will always scramble when the test is generated. Once you create a matching question, the number of pairs is displayed next to the question abbreviation in the Selection window.

An example is (MT - 6) for a question with six matching pairs.

Fill-in and Essay-Problem Questions

- Use the “Underline” key on your keyboard for the Fill-in area of the question.
Module 3: Creating Questions

Creating a New Question

ParScore can combine subjective points with objective scoring to record the total grade. In order to do this, the maximum credit the student could earn for all subjective questions is entered into the Subjective Score box located in the key tab of ParScore. Prior to scanning the form, the instructor will grade the subjective questions and mark the points earned in the Exam Number field on the score form. ParScore will then combine the subjective points with the objective scoring to record the total grade.

To Create a new question:

1. Select the Objective for the Item Bank
2. Select File, New, Question or the icon on the tool bar
3. Select the Question Type and press OK
4. Enter a Name for the Question
5. Enter the Question Text
6. Enter the available answers and select the correct answer(s) using a check mark from the Answer Tab.

If you chose Matching Questions:

Matching Questions: The display lets you scroll matching questions to view the number of the stimulus for each question and the associate response frequency information within each question.

Notes: Matching Questions will always scramble when the test is generated.

You can create odd matching problems. Odd matching problems contain more answer choices than questions. Leave the Question field empty, and enter an answer in the Choice field.
Once you create a matching question, the number of pairs is displayed next to the question abbreviation in the Selection window. An example is (MT - 6) for a question with six matching pairs.

If you chose Fill-in or Essay-Problem Questions

**Note:** Use the “Underline” key on your keyboard for the Fill-in area of the question.
The “Answer” Tab

The Answer Tab is where you specify the Available Answers and the Correct Answer. You may also enter an Explanation/Rationale.

Use the Operator when you have multiple correct answers. “And”/“Or” responses. When you import your key into ParScore, the “And” is A+B+C and the “Or” is ABC. Keep Answer Order and Keep Question Order.

Keep Answer Order:

Will prevent the choices from scrambling when you generate the test.

Keep Question Order:

Will prevent the questions from moving out of sequence when used with an instruction.

**Note:** You need to place two or more questions with the “Keep Question Order” option together on the test to use this feature. Edit, Tools, and Options pull-down menus

**Edit pull-down menu:**

1. Undo
2. Cut, Copy, and Paste
3. Delete
4. Find, Find Next, and Replace

**Tools pull-down menu:**

1. Align Text or Graphics – Left, Center, or Right
2. Effect – Superscript or Subscript
3. Spell Check the field where your mouse is located or the Entire Item Bank
4. Lock Question allows the Primary user to protect their questions from being changed by their Secondary users.

5. Insert Multimedia File (i.e. movies or sound files: for ParTest Online only)
   a. Pictures may be inserted in the question or answer fields of a question.
   b. Sound or short movie files may only be used for tests used with ParTest On-Line.

Option pull-down menu:

1. Keyword List: this can be used if you need to add to your current Keyword List.

The “Score” Tab
The Score Tab is where the “Score Details” are selected.

2. Enter the Point(s).
   The “Level” (Easy, Medium, or Difficult and Low, Medium, or High) is based on the Difficulty and Discrimination settings. The data is posted from ParScore.

3. Enter Penalty (optional). The Penalty will subtract from the remaining correct score of the student if they miss this question depending on the scoring options you use in ParScore.
Score Mode

- Active - Normal Point assignment
- Auto Credit - Everyone gets credit
- Pilot - Zero Points

Score Mode:

1. Active: Normal Point Assignment adds the number of points entered in the Points field for a correct answer and deducts the number of points entered in the Penalty field for an incorrect answer (Points are not deducted if the student does not answer the question)

2. Auto Credit: Everyone Gets Point(s) adds the number of points entered in the Points field whether the answer is correct, incorrect, or skipped

3. Pilot: Zero Points does not add or deduct points regardless of the answer

The “Keyword” Tab

The Keyword Tab is used to tag the question with one choice from each list.

Once your Keyword Labels are set up, you can add your Keywords List.

Notes:
The "Item Analysis" and "Response Frequencies" Tab

### Item Analysis Tab: Last and Cumulative

Item Analysis is posted from ParScore and cannot be entered from the keyboard. The "Last" column displays information from the last use of the question. The "Cumulative" column displays information from all uses of the question.

The Item Analysis displays the following:

1. **Number of Students taking the Test Item**
2. **Item Difficulty** (group total percentage of correct responses)
3. **Percentage of the upper and lower 27% of the group with correct responses.**
4. **Discrimination Index (Point-Biserial Correlation Coefficient)**

### Response Frequencies Tab

As with the Item Analysis tab, Response Frequency information is posted from ParScore and cannot be entered from the keyboard. The "Last" column displays information from the last use of the question. The "Cumulative" column displays information from all uses of the question.

<table>
<thead>
<tr>
<th>Answer</th>
<th>Score</th>
<th>Keyword</th>
<th>Item Analysis</th>
<th>Response Frequencies</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Answer</th>
<th>Score</th>
<th>Keyword</th>
<th>Item Analysis</th>
<th>Response Frequencies</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Module 3: Creating Questions

Adding a Graphic to your Question

1. Open the Graphic in Paintbrush and Copy the graphic.
2. Open the Question in ParTest and Select Edit - Paste into the Question and/or the Answers.

You can use the Zoom button on the Toolbar to view the entire graphic. The graphic can be re-sized and aligned.

Locking Questions

You can lock a question to prohibit secondary users from editing or deleting it. Reverse the process to “Unlock” the Question.

1. Double-click on the Question
2. Select Tools, Lock Question
3. Select OK

Copying Questions

You can copy questions from one objective to another. All the information associated with the question is copied with the content. This information includes keywords, points and penalties, item analysis, and response frequencies.

1. Open the objective
2. Select the question
3. Drag and drop the question into the new objective.
4. Select Yes, if you want to preserve the original item analysis and response frequency information.

Note: ParTest does not offer a "move question" options. You can achieve the same result by copying a question and then archiving or deleting the original.
Insert Other Graphic Types

The types of graphic files you can insert include JPEG (*.jpeg, *.jpg, *.jfif, and *.jpe), GIF (*.gif and *.gfa), TIFF (*.tif and *.tiff), and BMP (*.bmp).

To insert a graphic into a question, double-click a question to edit. On the Question Edit Toolbar, click on the “Insert Multimedia File” button. (You can also select “Insert Multimedia File” under Tools in the menu bar).

Caution: ParTest will convert the graphic file formats to a bitmap format, which will be a different size than the original graphic file (.jpg, .gif, or .tif). The maximum size of the converted bitmap file is 512 kb (512,000 characters). Movie and sound files can only be used in on-line tests with ParTest On-Line.

You will see the format selection options in the “Insert Multimedia File” dialog box in the dropdown menu labeled “Files of type.” Simply browse your files, select a graphic file to insert, and click Open.

Notes:
Insert Special Characters

Special characters and symbols, such as those used for mathematics and foreign languages, can now be inserted into questions and instructions. To insert a symbol or special character, open a question to edit. Then click the “Insert Symbol” button on the Edit Question Toolbar.

A “Character Map” window listing the available fonts for the special characters and symbols will appear.

Select a Font, click on the desired symbol, and then click the Select button to place the symbol into the “Characters to copy” field. This can be repeated for multiple characters if you would like to insert more than one special character into the question.

When all desired symbols have been added to the “Characters to copy” field, click the Copy button to copy the symbol(s) to the Windows Clipboard. You can now minimize or close the Character Map window. Place the cursor in the appropriate place in the question and select Paste from the Edit menu to paste the symbol(s) into the question. If you have chosen to insert multiple symbols, you can cut and paste them into the appropriate positions as needed.
How to import existing tests into the ParTest system via ASCII Option II File Format

1. **Open** a test from an RTF (Rich Text Format) or Word file.

2. **Copy** and **paste** the test into Notepad by:
   - Choose “**Start**”
   - Choose “**Run**”
   - Type in “notepad” and hit “**OK**”
   - Notepad will open allowing you to paste
   - Either “**Edit**” and “**Paste**” or **Ctrl** “**V**”

3. Important Notes:
   - All items must be of the same question type
   - An * (asterisk) is placed in the parenthesis indicating the correct answer
   - There are two spaces after each (“”) parenthesis
   - A separate file needs to be created for each question type
   - The questions must begin with number “1” and then stay in sequence
   - You can import up to 99 questions total
   - You can create up to five answer choices (A,B,C,D,E)
Module 3: Creating Questions

Formatting Questions For Import

1. Save the Notepad file on your desktop with a .txt ending
2. Open ParTest
3. Choose “File”
4. Choose “Import”
5. Choose “Item Bank”
Time Saving Tip for Formatting

You can use the “Replace” option in Notepad allowing you to quickly format your answers and questions.

**Note:** File MUST HAVE consistent formatting for this Quick Time Saving Tip to work throughout the entire file.

1. Highlight the changes to be made - example we want the highlighted section to be changed to A) **two spaces** then start of the sentence.

   1. Got to **Edit\Replace** \“As shown in the above screen shot”
Module 3: Creating Questions

Steps for using Find/Replace:

1. Copy and paste what you would like to change
2. Enter what you want it changed to (A) with two spaces before the sentence start
3. Choose “Replace All” and the system will change every item that is the same format as you have put into “Find what”

Notice where it has changed “ALL” the formatting as specified

4. Open your .txt file you saved to the desktop

Remember to change the file type to (*.TXT)
5. Import as a “New Item Bank”

6. Click on “OK”

You will see your imported file under the Test Bank you chose and the questions will be in their correct format with the answer checked as indicated.

The questions can now be used on any test.
Other Question Formats For Import

**True/False Questions**
The format in the ASCII file for True/False Questions is as follows:

```
TF
1) The lungs are the primary way the body brings air into the body.
   *) T

2) The heart only takes care of the oxygen levels in the blood.
   *) F
```

After importing the questions (up to 99 questions in one file), the imported question will look like the picture below.

**Matching Questions**
The format in the ASCII file for Matching Questions is as follows:

```
MT
1) Circulation is helped by:
   *) Heart

2) Pulmonary is helped by:
   *) Lungs
```

*Caution:* You will still have to open each question and type the answer since the system does not know if you will be using True/False, T/F, Yes/No, Y/N, etc.
After importing the questions (up to 99 questions in one file), the imported question will look like the picture below.

**Note:** Matching imported questions only import one single question per Matching Unit. No Matching Group Units will import as a whole.

**Fill in Questions**

The ASCII format for Fill In Questions is:

\[ FI \]

1) The ADL Assessment of a patient is the ________________ .

*) Activities of Daily Living

2) The __________ Scale is used by a nurse to assess the Risk for pressure ulcers as an aspect of older adult functioning.

*) Braden

**Essay Questions**

The ASCII format for Essay Questions is:

\[ EP \]

1) Describe in detail: The symptoms of high blood pressure with the ranges of Systolic and Diastolic measurements. The symptoms of low blood pressure with the ranges of Systolic and Diastolic measurements.

*) Essay should discuss the symptoms of high blood pressure, the measurements for each corresponding level, the symptoms of low blood pressure and the measurements for each corresponding level.
Importing existing Tests in RTF Format

1. Select File, Import, Test
2. Select the File Type
3. Select Files of type (see below)
4. Select the desired file
5. Select Open

Hint: Sentences cannot be wrapped in the text file as you see below. All sentences for questions and answers must be on one line. You may want to consider manually entering Matching, Fill In, and Essay questions rather importing them.

1. MC Martin _____ has a snack in the afternoon before he starts his homework.
   A. always
   B.* always
   C. always

2. MC Choose the word that is spelled correctly:
   A.* stop
   B. staupt
   C. stowp

3. TF Garcelle spent all day trying to make the words in his poem rhyme. The underlined word is spelled correctly – True or False?
   A.* True
   B. False

4. MC Which answer means the same or almost the same as the underlined word. We need to choose players for the game.
   A. find
   B.* pick
   C. make
   D. None of the above
Possible Errors:

The question prior to the error will import into the new item bank. After modifying the RTF file, delete the existing item bank or change the name during the next import.

Viewing Item Banks and Questions

After you have created Item Banks, you can view the Item Bank by several options. Only one Item Bank can be open. The view options assist you in creating tests by sorting and displaying questions within the Item Banks that meet your specific criteria.

Select the View menu and enter the selections to change the sorted view.

1. To “Reset” the View - Select “Question Name” from the View menu.

**Hint:** Highlight the objective within your item bank before viewing your options.
Module 4: Creating & Generating a Test

You create Tests by moving questions from the Item Bank Objective into the Test Contents window. You can use the View options to customize the sorting and to control which questions are displayed.

**Note:** A single Test can contain up to 200 Questions.

1. Select File, New, Test or the icon on the toolbar
2. Enter the Name and Description of the Test
3. Select OK

**Note:** Do NOT make the name more than NINE characters if you are using ParTest On-Line. There are 10 Reserved characters for the User folder with an underscore preceding the name of the test.

Assembling a Test

The Test is assembled in the Test Contents Window. You will drag-and-drop instructions and questions from the left pane into the right pane to create the exam.

1. Choose the Instruction(s) you wish to add to the Test Contents Window (Instructions are optional).
2. Open the Item Bank and Objective that contains the questions you want to choose (use the View Options to locate a series of questions).
3. Select the questions and drag-and-drop (or use the Insert Key) into the Test Contents window.

**Note:** You can use the “CTRL key” or “SHIFT key” to select multiple questions. You can also select the question(s) and use the Insert key.

You can add questions from one objective at a time.
Module 4: Creating & Generating a Test

Adding Questions to the Test Contents Window

1. Make sure your test is open
2. Multiple questions within a range may be selected by checking top question, hold down the shift key and select by checking the last question in the range.
3. Drag questions from left to right and drop into the test window

View of an Assembled Test (Instructions and Questions)

The Test Contents will show you the order of the Questions and what Item Bank and Objective the questions originated.

You can tell this test has not been generated since there is no test version. After generating a test, the drop down will show which version you are currently viewing.
Setting Secondary Users for Test
To grant Secondary User privileges to a test, right click on the Test and select Properties. Select the secondary user accounts to add in the dropdown menus of the Test Information dialog box. Click OK. Secondary users can view and print a test, but they cannot add, edit or delete it.

Set Font for Entire Test
Users can select a font type and font size to apply to a particular test. This is useful in cases where items included on a test were originally created using different fonts. By selecting a font for the test, all questions will appear with a consistent font. To set a common font for a test, right click the test in the Selection window and select Properties. In the Test Information dialog box that appears, click the “Set Font for Entire Test” checkbox in the lower right corner and select the desired font and size in the dropdown menus.
When a font is set for a test, the questions will appear using this font when viewed in the Quick Preview window, the Print Preview, and when output to a printer. (Note that the header, footer, date, and page number for a test are controlled by the user's Preferences under the Options menu.) The font of the original item in the item bank will not be altered.

Generating Tests:

1. Select Tools
2. Select Generate Test Versions or you can select the Generate Test Versions icon on the toolbar
3. Select “Generate Single Test Version” or “Generate Two or More Test Versions”

When you select “Generate Two or More Test Versions” – you have the option of Scrambling Questions and/or Answers.

Matching Questions are always scrambled.

You can create up to 26 versions. The standard ParScore forms can accommodate up to four versions (A, B, C, D). Version A, prints in the order that you originally assembled the items. Be sure to verify the ParScore form you will be using before creating multiple versions.

Note: You can protect the answer order in the properties of the Question by selecting “Keep Answer Order”.

Making Changes to a Generated Test

1. In order to make changes to a generated test; you will need to undo generate of the test first.
   a. Select Tools, Generate Test, Undo generated

Resolving Invalid Instructions and Questions

Invalid items occur when an instruction or question has been removed from the Item Bank. When you retrieve a test that contains invalid items, you are notified by an alert message. Undo generate of the test, delete the invalid questions or instructions, add new items as needed, and then generate new versions of the test - OR - Delete the test and create a new test.
Exporting Tests

You can export tests to other applications, such as Microsoft Word, in a Rich Text Format (*.RTF) or in an HTML format. Tests must be generated before exporting. Once you export the test such as to RTF (Word) format, you can make cosmetic changes to the exam in Word. Cosmetic changes include spelling corrections, changes to font type or size, the inclusion of headers or footers, or similar actions. You must be careful not to change the content of a test question or answer, or the order and sequence of questions or answers. Since none of the changes you might make in the Word document will be captured by ParTest, making any significant changes to the subsistence of a question would invalidate your item analysis.

You can select Test Questions Only or Test with Selective Information.

**Note:** If a test contains invalid items, you will need to resolve them before exporting.

1. Select the Test you want to Export
2. Select File, Export, Test
3. Select “Test Questions Only” or “Test with Selective Information”
4. Select Export
5. Enter the File Name and desired location
Module 5: Printing Tests & Reports

Six Report types are available for you to print:

1. Test Questions Only / Test and Selective Detail
2. Test Key
3. Test Blueprint
4. Answer Sheet
5. Item Bank Details
6. Item Bank Cross-Reference

Hint: You must have the cursor focus within an item bank for the item bank reports to be active (selectable)
Module 5: Printing Tests & Reports

Printing Reports:

1. Select and Open the Item Bank or Test you wish to print
2. Select File, Print
3. Choose a report type from the list
4. Select OK and then Select Print

Each report can be printed with the date stamp and/or page numbers. Headers, Footers, Print Date, and Print page number are available for Test and Selective Details or Item Bank Details reports only. Tests and Test Details and Item Bank Details are printed in portrait only.

Hint: When printing Selective Details for Tests and Item Bank Details reports will look identical. The important difference is, the Selective Details report will be looking at the question data as a snapshot of that specific test and how the questions performed. The Item Bank Details looks at all questions within the Item Bank and will be comprehensive.

Exporting Reports

Each of the following reports can be exported to a Disk file, Lotus Notes database, Microsoft Exchange folder, Lotus cc=mail, or Microsoft Mail (MAPI) program.

- Test Key
- Test Blueprint
- Answer Sheet
- Item Bank Cross-Reference
Module 5: Printing Tests & Reports

Test Questions Only

Version A

Please mark the single best answer for each question. If there is more than one answer, it will be indicated in the question.

Section 1 - Abuse
Questions 1-3

1. A nurse observes another nursing assistant hitting an 85-year-old patient with the diagnosis of dementia. What is the best action of the nurse? A. Report the observation to the nursing supervisor; B. Confront the nursing assistant and state, “If I ever see you hitting a patient again, I will have to report you.” C. Call the police; D. Ignore the action because the nursing assistant is good to all the other patients.

2. A nurse suspects that her 85-year-old next door neighbor is being abused by her daughter. The best action of the nurse is to: A. Not get involved because the neighbor is not one of the nurse’s patients; B. Plan to visit the neighbor frequently and then confront the daughter with her suspicions; C. Complete a confidential report with the adult protective services in the area; D. Ask the neighbor if she is being abused.

3. A 78-year-old wealthy widow with mild dementia lives with her son. She is admitted to the hospital for pneumonia and is noted to have burns on her upper back. The son states his mother is burned from the shower. Which of the following statements by a nurse suggests a need for further education? A. “This could not possibly be elder abuse. She is wealthy and abuse does not happen in these circumstances.” B. “Even if we are not sure, we should report our suspicions.” C. “Most abusers are either adult children or spouses.” D. “The incidence of abuse increases when more care is needed by the caregiver.”

Test and Selective Details

Version A

Instruction Name: Instruction for Staff
Please mark the single best answer for each question. If there is more than one answer, it will be indicated in the question.

Instruction Name: Section 1 - Abuse
Sections 1 - Abuse
Questions 1-3

1. Question Name: Abuse 0001 Type MC Objective Abuse ItemBank: Gerontology
   A nurse observes another nursing assistant hitting an 85-year-old patient with the diagnosis of dementia. What is the best action of the nurse?
   A. Report the observation to the nursing supervisor;
   B. Confront the nursing assistant and state, “If I ever see you hitting a patient again, I will have to report you.”
   C. Call the police;
   D. Ignore the action because the nursing assistant is good to all the other patients.

Correct Answer: A
Explanation: Reason:
Reference Note:
Keywords:
Nursing Process: D. Implementation
Blooms Taxonomy: C. Application
Points: 1.00 Penalty: 0.00 Scoring Mode: Active
Date Created: 04/12/30144218 Date Modified: 08/19/104219629522 Date Used: 03/201270412052
Difficulty: E
Item Analysis:

Correct Response: 24 No. of Students Responded: 97
Total Group: 100.00
Upper 25% of Group: 100.00
Lower 25% of Group: 100.00
Point Biserial: 0.00

Response Frequencies (%)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>100.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cumulative</td>
<td>95.01</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
### Test Key Report

These columns display the keyword list choices chosen for the two keyword labels set in the Preferences > Test Window dialog box.

#### Test Key Report - Exam 1 Version A

<table>
<thead>
<tr>
<th>No.</th>
<th>Answer</th>
<th>Item Bank Name</th>
<th>Objective Name</th>
<th>Question Name</th>
<th>Type</th>
<th>Difficulty Level</th>
<th>Discrimination Level</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Abuse 001</td>
<td>MC</td>
<td>E</td>
<td>L</td>
<td>D Implementation</td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Abuse 002</td>
<td>MC</td>
<td>E</td>
<td>L</td>
<td>B Analysis</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Abuse 003</td>
<td>MC</td>
<td>E</td>
<td>L</td>
<td>E Basic Care/Cons</td>
</tr>
<tr>
<td>4</td>
<td>C</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Abuse 004</td>
<td>MC</td>
<td>E</td>
<td>L</td>
<td>A Assessment</td>
</tr>
<tr>
<td>5</td>
<td>D</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Abuse 005</td>
<td>MC</td>
<td>E</td>
<td>L</td>
<td>A Assessment</td>
</tr>
<tr>
<td>6</td>
<td>D</td>
<td>Gerontology</td>
<td>Abuse</td>
<td>Neglect 001</td>
<td>MC</td>
<td>E</td>
<td>H</td>
<td>A Assessment</td>
</tr>
<tr>
<td>7</td>
<td>D</td>
<td>Gerontology</td>
<td>Aging</td>
<td>ACL 001</td>
<td>MC</td>
<td>E</td>
<td>H</td>
<td>A Assessment</td>
</tr>
<tr>
<td>8</td>
<td>E</td>
<td>Gerontology</td>
<td>Aging</td>
<td>Agian 001</td>
<td>MC</td>
<td>H</td>
<td>A</td>
<td>A Management of</td>
</tr>
<tr>
<td>9</td>
<td>D</td>
<td>Gerontology</td>
<td>Aging</td>
<td>Aging 001</td>
<td>MC</td>
<td>E</td>
<td>D Implementation</td>
<td>A Management of</td>
</tr>
<tr>
<td>10</td>
<td>C</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
<td>Stock 001</td>
<td>MC</td>
<td>E</td>
<td>A Assessment</td>
<td>A Management of</td>
</tr>
<tr>
<td>11</td>
<td>ArtFlex</td>
<td>Gerontology</td>
<td>Clinical Practice</td>
<td>Stock 001</td>
<td>MC</td>
<td>E</td>
<td>A Assessment</td>
<td>A Management of</td>
</tr>
</tbody>
</table>

### Test Blueprint Report

Category = Keyword Label; Keyword = Keyword List Choice

#### Test Blueprint - Exam 1

<table>
<thead>
<tr>
<th>Category</th>
<th>Keyword</th>
<th>Total Questions</th>
<th>Total Questions Excluding New &amp; Pilot</th>
<th>Mean Difficulty Last</th>
<th>Mean Discrimination Last</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Overall Test&gt;</td>
<td></td>
<td>31</td>
<td>20</td>
<td>79.93</td>
<td>0.12</td>
</tr>
<tr>
<td>1. Nursing Process</td>
<td>A. Assessment</td>
<td>16</td>
<td>13</td>
<td>89.72</td>
<td>0.09</td>
</tr>
<tr>
<td>2. Health Promotion andSafety</td>
<td>B. Analysis</td>
<td>4</td>
<td>4</td>
<td>72.95</td>
<td>0.05</td>
</tr>
<tr>
<td>3. Safety andInfection Control</td>
<td>C. Planning</td>
<td>8</td>
<td>8</td>
<td>71.66</td>
<td>0.18</td>
</tr>
<tr>
<td>4. Pharmacology andParenteral</td>
<td>D. Implementation</td>
<td>5</td>
<td>5</td>
<td>95.70</td>
<td>0.14</td>
</tr>
<tr>
<td>5. Client Needs (NCLEX)</td>
<td>A. Management of Care</td>
<td>19</td>
<td>17</td>
<td>87.83</td>
<td>0.16</td>
</tr>
<tr>
<td>6. Cites Need (NCLEX)</td>
<td>B. Safety andInfection Control</td>
<td>1</td>
<td>0</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>7. Health Promotion and Safety</td>
<td>C. Health Promotion andMaintenance</td>
<td>7</td>
<td>7</td>
<td>75.15</td>
<td>0.08</td>
</tr>
<tr>
<td>8. Basic Care/Cons</td>
<td>E. Basic Care/Comfort</td>
<td>2</td>
<td>2</td>
<td>97.95</td>
<td>0.03</td>
</tr>
<tr>
<td>9. Pharmacology and Parenteral</td>
<td>F. Pharmacology andParenteral</td>
<td>4</td>
<td>4</td>
<td>45.55</td>
<td>0.04</td>
</tr>
<tr>
<td>10. Bloom's Taxonomy</td>
<td>A. Knowledge</td>
<td>7</td>
<td>7</td>
<td>92.11</td>
<td>0.11</td>
</tr>
<tr>
<td>11. Bloom's Taxonomy</td>
<td>B. Comprehension</td>
<td>14</td>
<td>14</td>
<td>75.82</td>
<td>0.18</td>
</tr>
<tr>
<td>12. Bloom's Taxonomy</td>
<td>C. Application</td>
<td>9</td>
<td>7</td>
<td>81.54</td>
<td>0.02</td>
</tr>
<tr>
<td>13. Bloom's Taxonomy</td>
<td>D. Analysis</td>
<td>1</td>
<td>2</td>
<td>50.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
Answer Sheet Report

Form: ____  Student Name / ID: ______________________

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

For use when no automation exists (i.e. these sheets cannot be scored by our scanners.), manual grading only.

Item Bank Details Report

Question Name: Abuse 0001  Type: MC  Objective: Abuse  ItemBank: Gerontology

A nurse observes another nursing assistant hitting an 80-year-old patient with the diagnosis of dementia. What is the best action of the nurse?

* A. Report the observation to the nursing supervisor or
B. Question the nursing assistant and state, “I’ll see you hitting a patient again, I will have to report you.”
C. Call the police.
D. Ignore the action because the nursing assistant is good to all the other patients.

Correct Answer: A  Explanation: Reasonable action is to report the observation.  Reference Notes:  

Keywords:  

Nursing Process:  D. Implementation  
Client Needs (NCLEX):  A. Management of Care  

Item Analysis:

- No. of Students Responded: 24  
- Correct Responses (%): 92.91  
- Total Group: 100.00  
- Upper 27% of Group: 96.15  
- Lower 27% of Group: 92.21  
- Point Biserial: 0.07  

Response Frequencies:  

<table>
<thead>
<tr>
<th>Option</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100.00</td>
</tr>
<tr>
<td>B</td>
<td>0.00</td>
</tr>
<tr>
<td>C</td>
<td>0.00</td>
</tr>
<tr>
<td>D</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Cumulative: 92.91  

Item Analysis: Correlation:  

- Total Group: 96.15  
- Upper 27% of Group: 92.21  
- Lower 27% of Group: 0.07  
- Point Biserial: 0.00  

Correlation: 6.99  

Point Biserial: 0.00
## Item Bank Cross-Reference Report - Gerontology

<table>
<thead>
<tr>
<th>Keyword Category</th>
<th>Keyword Name</th>
<th>Question Name</th>
<th>Objective Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Nursing Process</td>
<td>A. Assessment</td>
<td>Abuse 0004</td>
<td>Abuse</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Abuse 0005</td>
<td>Abuse</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>ADL 0001</td>
<td>Abuse</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>ADL 0001</td>
<td>Aging</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Affect</td>
<td>Neurological</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Age related changes</td>
<td>Musculo-Skeletal</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Ageism 0001</td>
<td>Aging</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Aging 0001</td>
<td>Intimacy &amp; Sexuality</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Alzheimers Drugs</td>
<td>Neurological</td>
<td>MC</td>
</tr>
<tr>
<td></td>
<td>A. Assessment</td>
<td>Anxiety</td>
<td>Psychologic-Cognitive</td>
<td>MC</td>
</tr>
</tbody>
</table>
Module 6: Managing: Instructions, Item Banks, and Tests

You can select the following options under Manage:

- Add/Restore
- Duplicate/Backup
- Delete

Duplicate/Backup of Item Banks

You may want to duplicate Instructions, Item Banks, and Tests to share with other users or for general back-up purposes.

**Item Banks:**
1. Select File
2. Manage Item Bank
3. Duplicate/Backup Item Bank
4. The file will have a *.BKP extension

---

You can select to “Duplicate by Owner Name” or “Duplicate by Password”

b. If you duplicate by Owner Name – only the Primary User can “Add” the Item Bank back into ParTest.
c. If you duplicate the Item Bank with a password, any ParTest user can “Add” the Item Bank – as long as you provide the password.

d. The password should be at least two characters, but is limited to 20 characters.

5. **“Add Item Bank”** is used to add the ParTest Item Bank (*.BKP).

6. **“Delete Item Bank”** is used to delete an existing Item Bank.

**Note:** You may Delete an Item Bank, but be aware that if the Item Bank contains questions used on an existing test, the test can no longer be used. If the Item Bank is deleted you will need to resolve the invalid questions. Refer to “Resolving Invalid Instructions and Questions” in the User's Guide. Before Deleting an Item Bank, duplicate it in case you need to restore it at a later time.

Follow the same procedures for Instructions or a Test

1. Duplicate/Backup of a Test will have an extension of *.BKT

2. Duplicate/Backup of an Instruction will have an extension of *.BKI

**Exporting Item Banks**

You may export Item Banks one at a time to other applications that support Rich Text Format (RTF) files or into a HTML Document.

1. You can select all questions or selective questions.

2. You can select the desired details for each question.

3. Select the Item Bank.


5. Select All Questions or Selective Questions.

6. Select Types of Information.

7. Select Export and enter a File name.
Importing existing Item Banks

You can import existing Item Banks from a text format or from a ParTest DOS file.

1. Select File, Import, Item Bank
2. Select the File Type
3. Select the ASCII (.TXT) or ParTest for DOS (.BNK) file.
4. Select Open

**Note**: Refer to Appendix in the User's Guide for ASCII file layouts. Select the option (Option I or Option II) that is the closet to your existing question format.

Use the “Save As” feature and save as a “Text Only” when saving the file in Word.

See: Importing existing Tests for Rich Text Formats
Appendix A: Adding Additional Dictionaries

Additional Dictionaries may be purchased directly from Wintertree-software.com. As of January 2012 – the extra dictionary for Windows can be ordered for $199.00. The following link will take you directly to the order page for Wintertree Software’s Spelling Products:

http://www.wintertree-software.com/dev/dict/spelling-engines.html

Wintertree Software is not affiliated with Scantron. The dictionaries are available from Wintertree for companies to add the “Spell Check” feature to their programs. ParTest Spell Check Setup will let you add these additional dictionaries obtained from Wintertree-Software.

Download the dictionary files to a temporary folder on your computer. Upon receiving the dictionary you will see that there are several different files. Two of these files are pertinent: SSCEMA.TLX and SSCEMA2.CLS

1. Copy all the files to the ParTest directory
2. The sschema.tlx and sschema2.clx must reside in the ParTestWin directory on your PC
3. Login to ParTest as a user
4. Select “Tools” and “Spell Checker Setup”
5. Select “Add” and Open the sschema.tlx
6. Select “Add” and Open sschema2.clx
7. Select OK

The additional dictionary is added and will be used along with the standard dictionary.
Appendix B: How to edit question(s) that are on generated test(s) Without an Archive of the original question

Quick Review:

1. Undo generate the test with the question that needs to be edited. Ensure that the test with the question has been chosen and is open then click the “Generate Tests” button on the tool bar.
2. This box will appear, after you choose the “Generate Tests” button. Click on “Undo Generated” button.

![Generate Test Versions Window]

3. A window will appear asking if you want to undo generated test. It will alert you that ALL version(s) of the test will be destroyed. Click the “Yes” button.

![ParTESTWIN Window]

4. A window will now appear confirming the previously generated test has been undone. Click the “OK” button.

![ParTESTWIN Window]
5. Double click the question to be edited. The question box will appear with that question.
6. In the question box, choose the “Score” tab.

7. Click the “Protected” button for the question. This will unprotect the question so that the change can be made.
An alert from ParTESTWIN will warn you that unprotecting this question may cause a problem if the question has been used in a test.

8. Choose “Yes” to continue.

It is advisable to rename the Question with something that will indicate to your organization that this question has changed from the original. Example used below is adding a “Rev a” to the name.

9. Make needed change(s) and select “OK”
The changed/renamed question is now viewable.

10. Last, re-generate the test with the new/changed question.

There will be a confirmation that the test generation is complete. Click “OK”.
Appendix C: Appendix D: Defining Attributes (Optional)

Attributes are characteristics that describe the Item Banks. Attributes are optional. The Administrator can change the eight default categories: City, State, County, School, District, Teacher, Level, and Term. Attributes identify the source of the item bank – use this option is the item bank is shared between multiple sites.

Attribute labels apply to all item banks. Changes and deletions affect all users. Only the System Administrator can define the attribute labels, but primary users can define unique attribute lists for their own Item Banks. Select the “Options” pull-down menu

11. Default Attribute Labels

12. Modify the Labels as desired

The Attribute Label is assigned by the Administrator

The user assigns the Attribute List.

<table>
<thead>
<tr>
<th>City:</th>
<th>Santa Ana</th>
</tr>
</thead>
<tbody>
<tr>
<td>State:</td>
<td>California</td>
</tr>
<tr>
<td>County:</td>
<td>Orange</td>
</tr>
<tr>
<td>School:</td>
<td>GS-Scantron Univ</td>
</tr>
<tr>
<td>District:</td>
<td>Orange County</td>
</tr>
<tr>
<td>Teacher:</td>
<td>James Green</td>
</tr>
<tr>
<td>Level:</td>
<td>Level II</td>
</tr>
<tr>
<td>Term:</td>
<td>(None)</td>
</tr>
</tbody>
</table>

Examples of Attribute Labels and Lists: Established Labels: City, State, County, Software Product, Created by, etc.

Note: The Attributes are not related to the Questions within the Item Bank. Keyword Labels and Lists are used to describe the Questions.
Module 8:
Quick Start Guide

First Time Setup: 1. Create User’s Login Names - Log in as the Administrator
2. Setting up the Default Keyword Labels & Lists (optional)

The “Basic Steps” 1. Log in as a User
2. Create an Item Bank
3. Create an Objective
4. Add Questions
5. Create a Test
6. Generate the Test
7. Print the Test

Logging In To the System 1. After installing ParTest, you need create a Login name and Password for each user.
2. Open ParTest.
   a. The Login name is: administrator.
   b. The Password is: partest (not case sensitive)
3. Select Tools, Administration
4. Select Add
5. Enter a Login Name and Password for each user

Setting Default Keyword Labels/Lists 1. Setting up the Default Keyword Labels and Lists.
   a. Keyword Label: Select Options, Default Keyword Label
b. Keyword List: Select Options, Default Keyword List. The Keywords are used to describe the questions. (e.g.: This question is from Chapter 1, Source is Textbook, Topic is Reading)

<table>
<thead>
<tr>
<th>Keyword Label</th>
<th>Keyword List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nursing Process</td>
<td>Assessment, Analysis, Planning, etc...</td>
</tr>
<tr>
<td>Client Needs (NCLEX)</td>
<td>Management of Care, Safety and Infection Control, etc...</td>
</tr>
<tr>
<td>Blooms Taxonomy</td>
<td>Knowledge, Comprehension, Application, etc...</td>
</tr>
</tbody>
</table>

**The “Basic Steps”**

1. Log in as a User
2. Create an Item Bank
3. Create an Objective
4. Adding Questions
5. Create a Test
6. Generate the Test
7. Print the Test

**Expanded Basic Steps**

1. Log in as a User
   a. Open ParTest
   b. Enter your User name and Password
2. Create an Item Bank
   a. Select File, New, Item Bank or the icon on the Tool bar (shown below)
b. Enter a Name for the Item Bank

**Note:** An Item Bank can contain up to 5,000 questions. The “Path” shows the folder associated with your Login Name (U6778012). Everything you create will be saved to this folder. Each user will have a unique folder number.

3. Create an Objective

<table>
<thead>
<tr>
<th>Name:</th>
<th>Assessment</th>
<th>Date Created</th>
<th>02/15/10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Total Questions:</td>
<td>57</td>
<td></td>
</tr>
</tbody>
</table>

   a. Select File, New, Objective or the icon on the Toolbar (shown left)

   b. Enter a Name for the Objective

   Objectives are created within an Item Bank to provide a more specific focus for a group of closely related test questions. You create an objective to reflect or specify the course and the questions stored within it. An item bank can contain up to 200 objectives.

4. Adding Questions

   a. Select File, New, Question or the icon on the Tool bar (shown below)

   b. Select the Type of Question desired

   c. Enter a name for the question

   d. Enter the question text and the available choices

   e. Select the correct answer

   f. Select your keyword list items on the Keyword tab
5. Create a Test

   a. Select File, New, Test or the icon on the Tool bar (shown below)

   b. Enter a Name for the Test

![Image of file icon with name Exam 1]

   Note: When you select a question a “red” check is placed next to the question.

   c. Select the items from your Objectives and drag them to the “Test Contents” window on the right.

   d. You may also select the question and click the right mouse to “Add Selected Question to Test” or press your “Insert” key when the question is selected.

   e. Continue until all the questions are added to the test.
6. Generate the Test
   a. Select Tools, Generate Test Versions or the icon on the Tool bar (shown below)
   b. After you have assembled a test, you must generate the test before printing.
      - You can generate one or multiple versions of a test.
      - Multiple versions can scramble questions and/or answers.
   c. Once the test is generated, you will see the version(s) show in the dialog box.

7. Print the Test
   a. Once the test is generated you can print or preview it.
You’ve just purchased ParSystem, a powerful software solution that helps universities, corporate training departments and other educational institutions create, administer, and score tests on paper, via networks, or over the Internet. Using unified item banks, easy test creation, and a variety of administration methods, ParSystem enables your organization to make better test questions—questions that are reliable and valid to accurately measure student achievement. With ParScore, you can easily develop and manage student records and test data, including customized class rosters. Many other tracking, viewing and data manipulation options are available. You can define your own grading criteria, and report scores and grades as Raw, Percent, Stanine, T-Score, Z-Score, Percentile, and User-defined T-Score. You can also merge student test results from standardized tests so performance can be compared across classes or schools institution-wide. With ParTest, you can share item banks with other users and create up to 26 versions of your tests. Use the “Quick Pick” feature, to automatically choose your test questions from the item banks. With ParTest Online, you can import files that allow test takers to work via computer on a proprietary network or over the Internet. ParSystem elements work together to give you a consistent, easy, and unified assessment approach.